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This manual contains information about how to use Photomatix Pro to adjust images 
using diff erent Tone Mapping or Exposure Fusion methods. All of the methods are 
accessed from one window within the application, making it easy to try diff erent settings 
to achieve the results you want. Refer to Section 2, Loading and Pre-Processing 
Images and Section 3, Adjusting Images Using Tone Mapping or Exposure Fusion 
for detailed information about the diff erent settings that are available.

Introduction
Photomatix Pro works with photographs of the same scene taken under diff erent 
exposure settings. These diff erently exposed images of the same scene are often called 
“bracketed” images in reference to the auto- bracketing exposure functions available 
on many camera models. If you have not taken any bracketed photo sets, you can start 
using Photomatix Pro with the sample images available from the download page of the 
Photomatix Pro website – http://www.hdrsoft.com. Use the information in Section 1, 
Taking Photos for HDR to try Photomatix with your own bracketed images. 
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The shooting phase is essential for getting 
good results with Photomatix. To 
photograph a high contrast scene, you 
need to take several exposures in order to 
capture information in both the highlights 
and the shadows of the scene. The 
exposures taken must properly cover the 
dynamic range of the scene, especially the 
shadows.

The number of photos you need depends 
on the scene. It also depends on the 
Exposure Value (EV) spacing separating 
the photos. If you take them in one-EV 
steps (e.g., -1, 0, +1 EV), you will need more 
photos than if you take them in two-EV 
steps (e.g., -2, 0, +2 EV). We recommend 
shooting in two-EV steps whenever 
possible.

High contrast scenes can be grouped into 
roughly two types depending on their 
dynamic range:

• Medium dynamic range scene: Most 
landscapes and other types of outdoor 
scenes fall into this category. Three 
exposures taken in two-EV steps (i.e. –2, 
0 +2 EV), or fi ve exposures taken in one-
EV steps, are usually suffi  cient for this 
type of scene.

• High dynamic range scene: A typical 
example is the interior of a room with a 
view outside the window on a sunny day. 
You need to take at least fi ve exposures in two-EV steps (or nine exposures in one-EV 
steps) to capture this type of scene, but you may need more. Taking the exposures 
manually is recommended in these cases.

The source photographs for HDR processing can be taken with digital or fi lm-based 
cameras. The only requirement is that the exposure can be adjusted when taking 
pictures. If you use a fi lm-based camera, you will need to scan the photographs into 
your computer before processing them (refer to Section 1.3).

1 Taking Photos for HDR

Three exposures of a medium dynamic range 
scene, taken in t2wo-EV steps
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 1.1 Setting up the Camera
• Set your camera to Aperture priority 

(the "A" setting) so that only shutter 
speed will vary between the exposures.

• Set a low ISO such as ISO 100, or lower if 
available.

• Turn off  the fl ash. The fl ash may try to 
balance the exposure of all the images, 
when the goal instead is a range of 
exposures.

• Use a tripod whenever possible. Even 
though Photomatix Pro off ers automatic 
alignment of hand-held photos, using 
a tripod is almost always better. DSLR 
cameras and some compact digital 
cameras off er Automatic Exposure 
Bracketing (AEB). This enables you 
to automatically take three or more 
exposures in a row; one at the proper 
exposure, one or more underexposed, 
and one or more overexposed. Follow 
these steps if your camera off ers AEB 
mode:

• Select the Continuous shooting mode 
on the camera’s drive setting. Consult 
your camera manual for model-specifi c 
instructions for using this setting.

• Set the camera to Auto Exposure 
Bracketing (AEB).

• If possible, use the camera’s self-timer 
setting, a cable release or a wireless 
shutter release to minimize camera shake.

Note
The continuous shooting mode may not always 
be the best strategy because camera shake 
may build up. It is recommended to use a 
method that ensures the least possible shake 
for each single shot, such as mirror lock-up 
functionality, if available.

AEB settings on a Nikon D7000
(3 frames, at +/- 2 EV)

Canon Rebel T2i/550D LCD showing AEB 
with +/-2 EV increments selected

• Set the exposure increment to +/- 2 for optimal exposure range. If your camera 
does not off er +/- 2 exposure increments, select the maximum possible. Consult the 
camera manual for model-specifi c instructions for choosing this setting.
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1.2 Selecting the Exposures
To get good results with HDR processing, your bracketed sequence must include 
photos that correctly expose highlights as well as photos that correctly expose 
shadows. The latter is especially important to prevent noise in the processed HDR 
image.

In the lightest photo of the sequence, the darkest shadow areas of the scene should be 
shifted at least into the mid-tones. To check this, use your camera’s histogram preview 
in playback mode. In your most overexposed photo, the left part of the histogram 
should be empty until 1/3rd of the histogram’s width. If this is not the case, add one 
or more photos taken with longer exposure times. Another option is to re-shoot the 
exposure sequence with the normal exposure set one or more EVs higher if your most 
underexposed image in the exposure sequence was too dark. This is the case when the 
histogram of your darkest image is completely empty on the right half.

The number of exposures needed depends on the dynamic range of the scene, in 
addition to the exposure increment. For most outdoor scenes, three exposures taken 
at +/- 2 exposure increments is suffi  cient, provided the scene does not include the sun. 
However, for the interior of a room with a bright view out the window, you will need at 
least fi ve images taken with an exposure increment of +/- 2, or nine images taken with 
an exposure increment of +/- 1.

In scenes with extreme diff erences between light and dark details, you should change 
the exposures manually to ensure you capture a wide enough range to cover your 
scene.

1.3 Using Film-Based Cameras
• Follow the camera setup listed at the top of Section 1.1 and the tips on selecting 

exposures in Section 1.2. Keep in mind that you will not have the option of 
previewing the live histogram to determine your exposure range.

• Scan fi lm or slides, not prints. Photo labs attempt to make the best print from each 
of your source images, and you will not achieve good results scanning these for HDR 
generation.

• Turn off  your scanner’s auto-exposure options. This allows you to manually control 
the exposure.

• Make sure you select the Align images option in Photomatix Pro when combining 
your images.
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 2 Loading and Pre-Processing Images
This section describes how to load and merge 
bracketed image fi les of a scene taken under 
diff erent exposure settings as well as how to load 
single images into Photomatix Pro.

 2.1 Merging Bracketed Images
Photomatix Pro merges bracketed images that 
are in 8 bit or 16 bits/channel mode, as well as 
Camera RAW fi les.

Note

Note

Note

Note

The term “bracketed images” refers to 
images of the same scene taken under 
different exposure settings. This manual 
uses the term “bracketed images” to 
simplify how these images are defi ned. 
It also applies to the case when you 
have not used the Automatic Exposure 
Bracketing function of the camera to take 
the exposures.

Drag the image fi les for the exposure 
sequence at the same time, so the fi les are 
properly processed by the merge.

Newer camera models may not be 
supported by older versions of Photomatix 
Pro. To ensure your camera is supported, 
upgrade to the latest version.

If you have Lightroom, you can use the 
Lightroom Export Plug-in to load images 
into Photomatix Pro. Refer to Section 5 for 
more information.

Supported fi le types include JPEG, TIFF, PSD, DNG, and RAW fi les from many camera 
models. Photomatix Pro is updated frequently to add support for RAW fi les of new 
camera models

2.1.1 Loading Bracketed Images

To load bracketed image fi les, do one of the 
following:

• Drag and drop the fi les into Photomatix Pro

• Use the Workfl ow Shortcuts area or the File 
menu to load the fi les

Dragging and Dropping Bracketed 
Image Files

To drag and drop a group of image fi les to 
Photomatix Pro:

• Windows: Drag the fi les from Windows 
Explorer and drop them on the open 
Photomatix Pro program.

• Macintosh: Drag the fi les from the Finder 
and drop them on the Photomatix Pro icon 
on your Dock.
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Using the Workfl ow Area or the File Menu

To load images using the Workfl ow Shortcuts panel or the File menu:

1. Click Load Bracketed Photos in the Workfl ow Shortcuts pane

 OR 

 Select Load Bracketed Photos from the File menu.

 The Loading bracketed photos dialog displays.

Selecting bracketed photos to load

2. Drag and drop the fi les into the Loading 
bracketed photos dialog

 OR 

 Click Browse. A dialog displays prompting for 
location of the fi les.

3. Select the fi les to load, using one of the 
following methods:

• Click the fi rst fi le, then press and hold the 
Control key (Windows) or Command key 
(Mac). While holding down the Control or 
Command key, click each of the other fi les 
you wish to select.

Note

Note

If you check the Show 32-bit 
unprocessed image box, you will be 
able to save the unprocessed merged 
imagein an HDR image fi le format such 
as Radiance or OpenEXR. Saving the 
32-bit HDR image is useful when you 
want to be able to process the image 
with other tone mapping settings later 
without having to pre-process and 
merge your bracketed photos again. 
However, you will still need to pre-
process and merge the photos if you 
want to use exposure fusion.

You will have to click the Tone Map / 
Fuse button, in the Workfl ow Shortcuts 
window, to go to the next step if you 
choose to Show 32- bit unprocessed 
image.

The order of the fi les in a bracketing 
sequence does not matter.Photomatix 
Pro automatically sorts the images 
based on the exposure information 
in the image fi les' EXIF metadata. If 
exposure information is not available 
in the EXIF data, Photomatix Pro 
directly evaluates the relative 
brightness of the photos.

• Click the fi rst fi le, then press and hold the Shift key. While holding the Shift 
key down click the last fi le. This will select all the fi les in-between the fi rst and 
last fi le.

3. Click Open (Windows) or Select (Mac).

4. Click OK.
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2.1.2 General Merge to HDR Options

After the bracketed images are selected, you can customize the steps performed before 
merging the images, such as aligning the images or removing 'ghosts'. Refer to the fol-
lowing list for a description of the options when merging bracketed images:

Alignment Options

The Align source images option 
is checked by default. It corrects 
misalignment problems when the 
camera moves slightly between 
the bracketed frames. Hand- 
held photographs have camera 
movement but even images shot 
on a tripod may have some slight 
camera movement as well, such 
as movement caused by wind, for 
example.

• taken on tripod: Select this 
alignment method when you 
used a tripod to take automatic 
bracketed photos. This method 
is fast, but corrects only for 
horizontal and vertical camera 
movement, and not for rotation or 
other types of motion. Selecting options to merge to HDR

(Note: This method was named 'by correcting shifts' in Photomatix Pro version 4 and 
earlier.)

• hand-held: Select this method when you did not use a tripod or when the images 
are diffi  cult to align. The 'hand-held' method corrects for several types of camera 
movement, including horizontal and vertical motion, rotation, and forward and 
backward movement. When the 'include perspective' option is selected, it corrects 
for every kind of minor camera movement.
(Note: This method was named 'by matching features' in Photomatix Pro version 4 
and earlier.)

Entering Exposure Values

If the exposure information cannot be located in the metadata of the image fi les, 
Photomatix Pro displays a dialog prompting your input of the relative Exposure 
Values of the images. Photomatix Pro also displays this dialog if two or more source 
images have the same exposure metadata.
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• Include perspective correction: This option 
requests that the 'hand-held' alignment method 
corrects for all types of camera movement, 
including rotation in all three dimensions, 
as well as horizontal, vertical, forward, and 
backward motion.

• Crop aligned images: This option removes the unneeded borders resulting from 
alignment adjustments. Unchecking it disables this, so that the resulting image has 
exactly the same width and height as the source images, but may have white areas 
around the edges..

• Maximum shift: Sets the maximum mis-registration shift that the alignment 
attempts to correct for, expressed as a percentage of the image dimensions. This 
setting does not need adjustment in most cases. A situation when adjusting this 
setting may be useful is when the camera barely moved between the bracketed 
shots. In this case, setting a maximum shift lower than 12% will restrict the number 
of alignment corrections searched, thereby reducing the risk of selecting an 
improper alignment correction.

Deghosting Options

Deghosting addresses the problem of artifacts 
that appear when combining the bracketed 
images of a dynamic scene. For example, if the 
moving subjects are people walking, the people 
will appear multiple times in the combined 
image, once for each frame, faded and in a 
diff erent position as if they were “ghosts”. This 
is why artifacts that arise from movement in a 
scene are commonly referred to as “ghosting” and the techniques to eliminate them are 
referred to as “deghosting”.

Show options to remove ghosts activates the Deghosting Options window, which 
will open after you select your merge to HDR options and then click the Align & Show 
Deghosting button. The Deghosting Options window provides an adjustable image-
wide Automatic Deghosting algorithm and, for more control over deghosting, a 
manually applied Selective Deghosting Tool.

Noise Reduction Options

The Reduce noise on option 
processes source photos with 
a high-quality noise reduction 
algorithm, and is recommended 
when processing RAW fi les 
directly in Photomatix. 

Note
The Align source images option should not 
be checked when your source images are 
stitched panoramas or when they are "fake 
exposures" derived from a single RAW fi le.

Note
The deghosting option is effective when 
you apply a Tone Mapping method (Details 
Enhancer, Contrast Optimizer, Tone 
Compressor) or the Fusion/Natural method.  
It is not effective for the other Exposure 
Fusion methods.

Noise reduction options
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Noise reduction is typically most helpful in dark areas of the source images, and these 
dark areas are more prevalent in the underexposed and, sometimes, in the normally 
exposed frames. 

With this in mind, you can use the Reduce noise on menu to specify that noise 
reduction be applied only to the darkest images in the bracketed set. Or, if you wish, 
noise reduction can be applied to all images in the set.

Strength: Increases or decreases noise reduction strength relative to the automatically 
determined default strength value, which is based on the noise level in the image. 
Values range from 50% to 150%.

Reduce Chromatic Aberrations

The Reduce Chromatic Aberrations option automatically corrects color fringing due 
to chromatic aberrations of the lens. Checking this option is recommended, given that 
chromatic aberrations tend to show around high contrast edges, and are particularly 
an issue for HDR images.

 2.1.3 The Deghosting Options Window

Select Show options to remove ghosts in the Preprocessing Options window, to 
subsequently access the Deghosting Options window. 

The Deghosting Options window
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The Deghosting Options window provides two deghosting methods: 

•   A Selective Deghosting Tool 

•   An adjustable Automatic Deghosting algorithm.

The Selective Deghosting 
Tool enables you to lasso-
select the specifi c areas 
of the image that require 
processing to remove 
ghosting caused by image 
to image movement of 
elements in the scene. 
Photomatix Pro uses the 
single image that it deems 
best exposed for the selected 
area's brightness, as the 
default deghosting target 
image. You may change 
the automatically selected 
deghosting target image 
to any other image of your 
choice, using the tool. 

Automatic Deghosting 
processes the entire image 
with an automated ghost 
reduction algorithm. It is 
useful with scenes with 
many small changes image 
to image, which are not 
practical to manually lasso. 
This deghosting method 
has the disadvantage of 
potentially degrading image 
quality, depending upon the 
nature of the scene, the type 
of ghosting, the number of 
source frames, and other 
factors.  When applying Automatic Deghosting, use the lowest setting that successfully 
deghosts the image.

The two alternate Deghosting method panels
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 2.1.4 Using the Selective Deghosting Tool

To use the Selective Deghosting tool, click and drag the mouse to draw a lasso around 
a region that requires deghosting. Ensure that the dashed line forms a fully closed 
loop.

Right-click (Windows) or control-click (Mac) inside the selected region and select Mark 
selection as ghosted area from the pop-up menu. The line around the selected area 
changes from dashed to solid, to indicate that the area is now selected for deghosting. 
You may make additional deghosting selections, following these same steps, to mark 
other image areas for deghosting.

At any time, use the Brightness slider to increase or decrease the brightness of the 
image. Or, use the Zoom slider to zoom in and out. 

If necessary, you can remove a region from the deghosting selection. Control click or 
right click inside an already marked region and click Remove selection from the pop-
up menu.

You may also change the image used as the deghosting target. Control-click or 
right-click inside an already marked region and click Set another photo for selection 
from the pop-up menu. The tool displays a pop-up menu with a list of the available 
exposures. Select an exposure value from the list.

A dotted selection being marked for deghosting
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The photo that the tool automatically sets for the selection is not always the most 
appropriate exposure choice. It is thus a good idea to check whether changing to 
another photo produces a better deghosting result.

Right-clicking a marked selection, to choose a diff erent replacement photo

To view a preview of the deghosted image, click Preview deghosting. To make more 
selections or modify existing regions selected for deghosting, click Return to selection 
mode. You may continue selecting regions of the image and previewing the results 
until you are satisfi ed with the results.

In Quick Selection Mode, every completed selection lasso will automatically be 
converted into a deghosting selection, without the need to individually "Mark 
selection as ghosted area". 
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 2.1.5 Using Automatic Deghosting

The Automatic Deghosting option 
automatically detects ghosted areas 
in the image. The slider sets the 
'aggressiveness' of ghosting detection. 

A high Deghosting setting removes 
more ghosting artifacts, but increases 
the possibility and severity of unwanted 
artifacts. Try to use a setting as low as 
possible, to preserve the quality of the 
merged HDR image.

If you need high settings to remove 
ghosts completely, it is recommended 
that you use the Selective Deghosting 
Tool instead, if possible. 

When automatic deghosting is used, 
one of the source photos is used to 
create the HDR image in areas detected 
as ghosted. The Base Photo is the one 
selected to do this. By default this is the 
median exposure, but you can select one 
of the other photos instead by clicking 
on its thumbnail.

After using the Selective Deghosting 
tool, or applying Automatic Deghosting, 
click OK to apply the deghosting 
adjustments to the image, or click 
Cancel to stop merging the images.

If you wish to continue working with 
the current bracketed set, but with 
no deghosting applied, then set the 
Automatic Deghosting amount to "0", or make no Selective Deghosting Tool 
selections, and simply click OK to proceed.

 

Automatic Deghosting tools
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 2.1.6 Options for RAW Files

Photomatix Pro off ers additional 
options for RAW fi les. These options 
are automatically available when 
RAW fi les are loaded.

The White Balance options let 
you change the white balance, if 
desired, and preview the eff ect of 
changing it. The default value is "As Shot", which reads the white balance setting from 
the EXIF metadata. To adjust the white balance, select a pre-defi ned value from the 
White Balance drop-down list or type a color temperature in Kelvin in the text box.

Click Preview sample to view the eff ect of the white balance change on the source 
image.

The Color primaries based 
on drop-down list provides 
options for converting 
the RAW data from the 
camera's native color space 
to the display profi le of the 
selected value. AdobeRGB 
is the default value and is 
appropriate when you want 
to print the resulting image. 
If you would like to display 
the resulting image only on 
the web and do not intend 
to print it, then select sRGB 
to avoid having to convert 
the image from AdobeRGB 
to sRGB. 

RAW conversion settings, in Merge to HDR Options

Merge to HDR Options window, for RAW fi les
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2.2 Working with Single Image Files
Photomatix Pro supports Tone Mapping of single image fi les. To load a single image 
fi le:

1. Drag the image fi le to the Photomatix Pro application (Windows) or icon on your 
Dock (Mac).

 OR

 Select Open from the File menu. A fi le browser window displays. Navigate to the 
fi le and open it.

 OR

 Click Load Single Photo in the Workfl ow Shortcuts window.

2. To process the image using Tone Mapping, click Tone Mapping from the 
Workfl ow Shortcuts panel. 

 If the fi le is a JPG, a dialog will show to let 
you decide whether to reduce the noise on 
your image before tone mapping. If desired, 
check Do not ask me again to skip this 
dialog and use your Yes or No selection 
for all single JPGs that you process with 
Tone Mapping. If you need to re-enable 
the dialog later, access the Photomatix Pro Preferences to change the setting. 
The Preferences are available from the View menu (Windows) or Photomatix Pro 
menu (Mac).

 2.2.1 Options for Single RAW Image Files

When your single image is a RAW fi le, Photomatix must fi rst convert the RAW data. The 
following options are available for pre-processing the RAW data.

The Reduce noise option processes 
the converted RAW fi le with high-
quality noise reduction. It is checked 
by default as reducing noise is always 
recommended when processing 
RAW fi les. The Strength slider lets 
you increase or decrease the strength 
of the noise reduction relative to 
the automatically determined value 
based on the noise level in the image. 
Values range from 50% to 150%.

The Reduce chromatic aberrations option automatically corrects color fringing due 
to chromatic aberrations of the lens.

Note
Tone mapping with the Details Enhancer 
method makes any noise present in the 
image much more visible, so it is a good 
idea to pre-process your image with noise 
reduction before tone mapping.

Reducing noise on a single image JPEG fi le
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The White Balance options let you change the white balance, if desired, and preview 
the eff ect of changing it. The default value is "As Shot", which reads the white balance 
setting from the EXIF metadata. To adjust the white balance, select a pre-defi ned value 
from the White Balance drop-down list or type a color temperature in Kelvin in the text 
box.

Click Preview sample to view the eff ect of the white balance change on the source 
image.

The Color Space drop-down list provides options for converting the RAW data from 
the camera's native color space to the display profi le of the selected value. AdobeRGB 
is the default value and is appropriate when you want to print the resulting image. If 
you do not intend to print the image, select sRGB for web-only images to avoid having 
to convert the image from AdobeRGB to sRGB.

Enable Exposure Fusion allows the image to be processed using the Fusion methods. 
Normally, Fusion methods are applicable only to multiple image sets. This option will 
split the single RAW fi le into darker and lighter images, which can then be fused.  This 
allows to use presets belonging to Exposure Fusion methods, such as the 'Natural' 
preset, for instance.

RAW Processing Options dialog box
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3 Adjusting Images Using Tone Mapping 
or Exposure Fusion

Photomatix Pro provides access to HDR Tone 
Mapping and Exposure Fusion methods in one 
interface, with three main sections: Adjustments 
panel, Preview and thumbnail Presets. 

This section describes the workfl ow for 
adjusting, previewing and processing images, 
and describes each Tone Mapping and Exposure 
Fusion setting. 

 3.1 Image Adjustment Workfl ow
After you have merged your source images (or 
opened a single image fi le), the next steps are:

1. Adjust the image to your liking: Choose a 
style you like from the thumbnails listed on 
the Presets window. You can then refi ne the 
eff ect by adjusting the controls in the Settings 
window. Refer to Sections 3.3 through 3.6 
for detailed descriptions of the settings. Refer 
to Section 3.2.3 for more information about 
using presets.

2. Process the image: When you are satisfi ed 
with the adjustments, click on the Apply 
button located at the bottom of the 
Adjustments panel to apply your settings to 
the image at its original resolution.

3. Finishing Touch: Once you have processed 
the image and before saving it, you may use 
the options on the Finishing Touch palette 
in order to increase the contrast of your 
image, sharpen it, or adjust the saturation of 
individual colors.

4. Save the image: When you have processed 
the image, you can save it. Select File - > 
Save As. Navigate to the folder where the fi le 
should be stored. Use the default fi le name or 
enter a name in the File name fi eld.

Note
Exposure Fusion is normally only available 
when bracketed photos are loaded. When a 
single image is loaded, only Tone Mapping 
is available.

Image adjustment settings panel
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 Select a fi le type:

• TIFF – 16-bit: the best choice for further 
processing

• TIFF – 8-bit: for use in applications that 
cannot work with 16 bit, or for avoiding 
too large a fi le size on disk

• JPEG: for use on the web without further editing

If you would like to automatically view the fi le with a photo viewing application after 
saving, you can click Open Saved Images with, in the Save dialog. Accept the default 
program or select a program from the drop-down list. If a desired program is not on 
the list, click Add application, navigate to the folder containing the program, select 
the program and click Open.

All saved images will now automatically open 
into the selected application. To turn off  this 
option, un-click Open Saved Images with, in 
the Save dialog. 

Note
The settings are automatically embedded 
in the saved processed image. To view 
the settings, click View Settings from the 
Workfl ow Shortcuts bar.

Note
To undo changes made during the 
adjustment process, click the undo 
arrow at the bottom of the adjustments 
panel.To redo adjustments, click the 
redo arrow to reapply changes.

3.1.1 Undoing Adjustments and Reprocessing an Image

After processing an image, you can return to Tone Mapping or Exposure Fusion to 
continue working with the same image set. There are two diff erent ways to do this, 
both accessed from the Workfl ow Shortcuts panel; Redo With Other Settings or 
Double Tone Map.

• Redo With Other Settings allows you to start fresh with the current image set, to 
apply entirely new presets and settings.

• Double Tone Map allows you to add additional eff ects, using your already-
processed image as the starting point. 

Note that you will still be able to use the Redo With Other Settings option if you fi rst 
save the image with the current settings applied.
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3.2 Image Adjustment Interface

3.2.1 Image Adjustment Interface Overview

The image adjustment interface consists of three main sections; setting Adjustments, 
image Preview and Preset thumbnails. The features of these three main interface 
sections are described in detail below.

Image adjustment Preview panel controls

3.2.2 Preview 

The image Preview displays the result of your 
current settings, for whichever Tone Mapping of 
Fusion method you are working in. 

Preview is updated immediately after a setting 
has been changed. Preview provides the 
following controls.

• Scaling Slider: Zooms in or out the refreshed 
preview from 50% to 150%. The preview is 
not recalculated but quickly scaled. Each 
time Fit or one of the Magnifi er icons is 
clicked the preview is recalculated and the 
Zoom Slider resets to 100%.

• Fit: Resizes the preview to fi ll the available 
space on the program's main window. 

• Magnifi er icons +/-: Increases or decreases 
the preview image by 20% and recalculates 
it at the new size. 

• Preview: The Preview checkbox quickly 
toggles between a preview of the image and 
the “normal” exposure (0EV) of the set. This is 
helpful to compare the eff ects of the image 
adjustments.

Note
When using the Details Enhancer or 
Contrast Optimizer methods, the Preview 
is not always an accurate representation of 
the fi nal tone mapped image.

Note
As an option, selectable in Preferences, 
the Preview will update continuously as you 
move a slider. This option may require that 
you work with your image zoomed out to a 
small Preview, or that you have a powerful 
computer that is able to quickly reprocess 
the Preview. This option is not available if 
you are running on a 32-bit OS.
You can access application Preferences 
from the View menu (PC) or Photomatix Pro 
menu (Mac).
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• Selection Mode: Checking the selection mode checkbox enables you to select an 
area of the preview and replace it with one of the source images. See Section 3.7 
for details.

• Histogram: This fl oating window contains four selectable tabs to assist in analysis 
of the image: Luminance, Red, Green, and Blue. In addition, move the mouse back 
and forth across the histogram to display Level, Count, and Percentile information. 
If the histogram is turned off , enable it by selecting 8-bit Histogram from the View 
menu.  

8-bit Histogram

3.2.3 Preset Thumbnails Panel

The Presets panel lists the available presets, showing a thumbnail preview of the eff ect 
of the preset on your image. When you click on a preset thumbnail, the Preview image 
is refreshed to show the result of applying the settings of the selected preset.

By default, the panel displays one column of small thumbnails. Click on the “plus” icon 
on the top of the panel to display the thumbnails at a larger size. Click on the icon on 
the top right of the panel to display the thumbnails in two columns.

If you prefer that the Presets panel does not show by default, you can set this as an 
option in Preferences. 

You can access the Photomatix Pro Preferences from the View menu (Windows) or 
Photomatix Pro menu (Mac).

There are two types of presets, built-in and custom. 
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Preset panel
Single column, large thumb view

Built-in Presets

Built-in presets are “factory” presets that are 
provided with the software. Photomatix Pro 
off ers 36 built-in presets when you are processing 
bracketed photos, and 27 when you are processing 
a single fi le. 

The pop-up menu at the top left of the Presets 
panel lets you view subset categories of built-in 
presets. You can display a selected subset of presets 
from all categories by selecting the “Short List” item. 

There are three categories of built-in presets 
corresponding to eff ect styles. They are: 
Artistic, Realistic and Black & White. 

There are four categories of built-in presets 
corresponding to processing methods. They are:
Details Enhancer, Contrast Optimizer, Tone 
Compressor and Fusion.

Custom Presets

Custom presets are presets that you saved while 
adjusting your images, or presets created by other 
Photomatix users that you have imported. 

To access custom presets, click on the My Presets 
tab located at bottom of the Preset Thumbnails 
panel. To create your own custom presets, refer to 
the Saving Custom Presets paragraph below. You 
can also import custom presets created by other 
Photomatix users that you downloaded to your 
computer as XMP fi les. To import the presets, select 
the item “Import Presets…” on the pop-up menu 
on the top left of the Preset Thumbnails panel, and 
browse to the location on your computer where you 
downloaded the XMP preset fi les. 

Saving Custom Presets

There are two ways to save custom presets as an 
XMP fi le for future use; during the image adjustment 
phase or after Tone Mapping or Exposure Fusion is 
complete.
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To save custom presets during image 
adjustment:

1. In the Adjustments panel, click the 
Presets drop-down list.

2. Select Save Preset from the list.

3. Enter a name for the preset in the File 
name fi eld and click Save.

To save the processing selections as a 
preset after Tone Mapping or Exposure 
Fusion processing:

1. Click Save Preset from the Workfl ow 
Shortcuts panel or select Save Preset 
from the File menu. 
A dialog prompts for the fi le name. 

2. Enter the fi le name and click OK.

Artistic built-in Presets
Two column, small thumb view

Note
If you save the preset in the default location 
(which is the Presets folder of the Photomatix 
Pro application), the preset is automatically 
added to the Presets combo-box list, and 
also shows on the “My Presets” tab of the 
Preset Thumbnails Panel.
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 3.3 Tone Mapping Details Enhancer Settings

General Settings
• Strength: Aff ects the amount of 

enhancement given to contrast and detail in 
the image. A value of 100 gives the greatest 
enhancement. Moving the slider to the left 
gives a more natural eff ect. The default value 
is 70.

• Saturation: Adjusts the color saturation of 
the image. The greater the saturation, the 
more intense the color. Setting the slider 
to its lowest value (0) produces a grayscale 
image. The default value is 46.

• Tone Compression: Adjusts the dynamic range of the tone mapped image. 
Moving the slider to the right decreases the dynamic range, brightening the 
shadows and darkening the highlights. Moving to the left has the opposite 
eff ect, giving a more 'natural' look. (This setting was named 'Luminosity' in older 
Photomatix versions.)

• Detail Contrast: Controls the amount of contrast applied to detail in the image. 
Moving the slider to the right increases the contrast of details and gives a sharper 
look to the image, but also has a darkening eff ect. Moving to the left decreases the 
contrast of details and brightens the image.

• Lighting Adjustments pane: The two lighting adjustment modes aff ect the 
overall 'look', controlling the extent to which the image looks natural or surreal.

• Lighting Adjustments slider: Aff ects the 
overall 'look', controlling the extent to which 
the image looks natural or surreal. Moving the 
slider to the right makes the image look more 
natural. Moving to the left makes it look more 
'painterly' or surreal.

• Lighting Eff ects Mode checkbox: Lighting 
Eff ects Mode lets you switch between two 
modes for the Lighting Adjustments setting, 
where each mode produces slightly diff erent 
results. Checking the box tends to produce 
results with a type of 'Magic Light' eff ect. 
Note that fi ner control is not possible in this 
mode.

• Lighting Eff ects Mode: Aff ects the overall 'look', controlling the extent to which the 
image looks natural or surreal.

Details Enhancer – General settings

Details Enhancer –
Lighting Adjustment settings

Details Enhancer – 
Lighting Eff ects Mode
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More Options

• Smooth Highlights: Reduces contrast 
enhancements in the highlights, preventing 
white highlights from turning grey, or 
preserving a uniform blue sky. It is also 
useful for reducing halos around objects 
placed against bright backgrounds.

• White Point: Sets the maximum value of 
the tone mapped image. Moving the slider 
to the right sets a lower maximum value, 
which brightens the image and increases 
global contrast. Moving to the left sets a 
higher maximum value, which decreases 
global contrast and reduces highlights 
clipping.
The default value is 0.25%.

• Black Point: Sets the minimum value of the tone mapped image. Moving the 
slider to the right increases global contrast. Moving to the left sets a lower 
minimum value, which decreases global contrast and reduces shadows clipping.

• Gamma: Adjusts the brightness of the midtones, which also has an impact on 
the overall contrast. Moving the slider to the right brightens the midtones and 
decreases the contrast. Moving to the left darkens the midtones and increases the 
contrast. The default value is 1.0.

• Temperature: Adjusts the color temperature of the tone mapped image relative 
to the temperature of the HDR source image. Moving the slider to the right gives a 
'warmer', more yellow-orange colored look. Moving it to the left gives a 'colder' more 
bluish look. A value of 0 (default) preserves the original color temperature of the HDR 
source image.

Advanced Options

• Micro-smoothing: Smoothes out the 
enhancement of 
small details, which has the eff ect of 
reducing noise in the sky for instance, and 
tends to give a 'cleaner' look to the result

• Saturation Highlights: Adjusts the color 
saturation of the highlights relative to 
the color saturation set with the Color 
Saturation slider. Values higher than 
0 increase the color saturation in the 
highlights. Values lower than 0 decrease it. The default value is 0.

Details Enhancer – More Options

Important Note
The Loupe may not properly show the 
effect of the Micro-smoothing setting 
when the area magnifi ed is uniform. If 
you want to see the effect of the Micro-
smoothing setting at 100% resolution on a 
uniform area such as the sky, you will have 
to select an area that contains an object in 
the scene in addition to the sky.



Photomatix Pro 5.0 User Guide 25

• Saturation Shadows: Adjusts the color 
saturation of the shadows relative to the color 
saturation set with the Color Saturation slider. 
Values higher than zero increase the color 
saturation in the shadows. Values lower than 
zero decrease it. The default value is 0.

• Shadows Smoothness: Reduces contrast 
enhancements in the shadows.

• Shadows Clipping: The value of the Shadows 
Clipping sets how much of the shadows range 
is clipped. This control may be useful to cut out 
noise in the dark area of a photo taken in a low-
light situation.

• 360º image: Checking this option eliminates the seam between the left and right 
sides of a panorama viewed in a 360 degree panoramic viewer. This option is 
intended for a stitched panorama - it should not be used for individual frames of a 
panorama that have not yet been stitched. 

3.4 Tone Mapping Contrast Optimizer Settings
• Strength: Aff ects the amount of 

enhancement given to contrast and detail in 
the image. A value of 100 gives the greatest 
enhancement. Moving the slider to the left 
gives a more natural eff ect. The default value 
is 50. 

• Tone Compression: Alters the dynamic range 
of the tone mapped image. Moving the slider 
to the right decreases the dynamic range, 
brightening the shadows and darkening 
the highlights. Moving to the left has the 
opposite eff ect, giving a more 'natural' look 
to the image.

• Lighting Eff ect: Controls the prominence 
of the shadows, aff ecting the overall look 
of the image. Moving the slider to the right 
brightens the shadows, giving a more 
'vibrant' or surreal look. A value of zero 
disables the eff ect, leaving the shadows 
unaff ected. The default value is 20. 

Details Enhancer – Advanced Options

Contrast Optimizer Settings
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• White Clip: Adjusts the amount of highlights clipping. Moving the slider to 
the right brightens the image and increases global contrast. Moving to the left 
decreases global contrast and reduces highlights clipping.

• Black Clip: Adjusts the amount of shadows clipping. Moving the slider to the right 
darkens the image and increases global contrast. Moving to the left decreases 
global contrast and reduces shadows clipping.

• Midtone: Adjusts the brightness of the midtones, which also has an impact on 
the overall contrast. Moving the slider to the right brightens the midtones and 
decreases contrast. Moving to the left darkens the midtones and increases contrast.

• Color Saturation: Adjusts the color saturation of the image. The greater the 
saturation, the more intense the color. Setting the slider to its lowest value (-10) 
produces a grayscale image.

• Color Temperature: Adjusts the color temperature of the tone mapped image 
relative to the temperature of the HDR source image. Moving the slider to the 
right gives a 'warmer', more yellow-orange colored look. Moving it to the left 
gives a 'colder' more bluish look. A value of 0 (default) preserves the original color 
temperature of the HDR source image.

• 360º Image: Checking this option eliminates the seam between the left and right 
sides of a panorama viewed in a 360 degree panoramic viewer. This option is 
intended for a stitched panorama – it should not be used for individual frames of a 
panorama that have not yet been stitched.  

3.5 Tone Mapping Tone Compressor Settings
• Brightness: Adjusts the overall brightness of 

the image.

• Tonal Range Compression: Controls the 
compression of the tonal range. Moving the 
slider to the right has the eff ect of shifting 
both shadows and highlights toward the 
midtones.

• Contrast Adaptation: Adjusts the contrast 
in relation to the average brightness. Moving 
the slider to the right tends to decrease 
contrast and give more 'pronounced' colors. 
Moving to the left tends to increase contrast 
and give a more 'natural' look.

Tone Compressor Settings
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• White Clip: Adjusts the amount of highlights clipping. Moving the slider to 
the right brightens the image and increases global contrast. Moving to the left 
decreases global contrast and reduces highlights clipping.

• Black Clip: Adjusts the amount of shadows clipping. Moving the slider to the right 
darkens the image and increases global contrast. Moving to the left decreases 
global contrast and reduces shadows clipping.

• Color Saturation: Adjusts the color saturation of the image. The greater the 
saturation, the more intense the color. Setting the slider to its lowest value (-10) 
produces a grayscale image.

• Color Temperature: Adjusts the color temperature of the tone mapped image 
relative to the temperature of the HDR source image. Move the slider to the right 
for a warmer, more yellow-orange colored look. Move it to the left for a colder, 
more bluish look. A value of 0 (default) preserves the original color temperature of 
the HDR source image.

3.6 Fusion Settings

3.6.1 Fusion/Natural Settings
• Strength: Sets by how much local contrast 

is accentuated. Moving the slider to the right 
tends to brighten the shadows and to show 
more details in the highlights. Moving to the 
left produces a more 'natural' eff ect.

• Brightness: Controls the brightness of the 
fused image by adjusting the infl uence 
each of the input photos has on the fi nal 
result. Moving the slider to the right gives 
the overexposed photos more infl uence, 
resulting in a brighter result. Moving to 
the left darkens the result by giving the 
underexposed photos more infl uence.

• Local Contrast: Increases the contrast and 
sharpness of details in the image. Increasing 
local contrast may have the side eff ect of 
making noise more visible and of creating 
thin halo eff ects around strong luminosity 
edges. Values near the maximum tend to 
give a surreal look to the image. The default 
value is 2.

Fusion/Natural Settings
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• Shadows Contrast: Increases the contrast of shadows in the image by darkening 
the areas of heaviest shadow and brightening the midtones, giving a more realistic 
eff ect.

• White Clip: Adjusts the amount of highlights clipping. Moving the slider to 
the right brightens the image and increases global contrast. Moving to the left 
decreases global contrast and reduces highlights clipping.

• Black Clip: Adjusts the amount of shadows clipping. Moving the slider to the right 
darkens the image and increases global contrast. Moving to the left decreases 
global contrast and reduces shadows clipping.

• Midtone: Adjusts the brightness of the midtones, which also has an impact 
on the overall contrast. Moving the slider to the right brightens the midtones 
and decreases contrast. Moving to the left darkens the midtones and increases 
contrast.

• Color Saturation: Adjusts the color saturation of the image. The greater the 
saturation, the more intense the color. Setting the slider to its lowest value (-10) 
produces a grayscale image. 

• 360º Image: Checking this option eliminates the seam between the left and right 
sides of a panorama viewed in a 360 degree panoramic viewer. This option is 
intended for a stitched panorama – it should not be used for individual frames of a 
panorama that have not yet been stitched. 

  3.6.2 Fusion/Real-Estate Settings

• Highlights: Adjusts bright areas in the image. 
Moving the slider to the right brightens 
the highlights. Moving to the left darkens 
highlights and recovers more highlight 
details.

• Shadows: Adjusts dark areas in the image. 
Moving the slider to the right brightens 
shadows and recovers more shadows details. 
Moving to the left darkens shadows.

• Local Contrast: Increases the contrast and 
sharpness of details in the image. Increasing 
local contrast may have the side eff ect of 
making noise more visible and of creating 
thin halo eff ects around strong luminosity 
edges. Values near the maximum tend to 
give a surreal look to the image. The default 
value is 2.

Fusion/Real-Estate Settings
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• Color Saturation: Adjusts the color saturation of the image. The greater the 
saturation, the more intense the color. Setting the slider to its lowest value (-10) 
produces a grayscale image.

• Highlights Depth: Aff ects the colors of the highlights in the image. Moving the 
slider to the right adds depth to the highlights, darkening the highlights and 
increasing their colorfulness.

• 360º Image: Checking this option eliminates the seam between the left and right 
sides of a panorama viewed in a 360 degree panoramic viewer. This option is 
intended for a stitched panorama – it should not be used for individual frames of a 
panorama that have not yet been stitched. 

3.6.3 Fusion/Intensive Settings

Strength: Adjusts the strength of local contrast 
enhancements.

• Color Saturation: Adjusts the color 
saturation of the image. The greater the 
saturation, the more intense the color. Setting 
the slider to its lowest value (-10) produces a 
grayscale image.

• Radius: Controls the area used to calculate 
the weighting of the source images. A higher radius reduces halos, but increases 
processing times signifi cantly. The default value is 70.

3.6.4 Fusion/Average, /Auto, /2 Images Settings

There are no setting options for the Fusion/
Average or Fusion/Auto methods.

The Fusion/2 Images method allows you to choose 
to fuse any combination of two images from 
among the loaded bracketed set. 

Fusion/Intensive Settings

Fusion/2 Images Settings
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 3.7 Replace Selection with Source

An HDR-processed image might look exactly the way you want, except for one area. 
For example, the sky might have more contrast or be darker than desired. The “Replace 
selection with source” feature lets you replace that area with the same area from any one 
of the source images, to bring the tonemapped or fused image closer to what you want.

 3.7.1 Selecting the Area to be Replaced

To enable this feature, click the Selection 
Mode checkbox.
The Polygonal Lasso is the default tool. 

We recommend using the Polygonal tool, but you can use the Normal or Magnetic tool
if you prefer. Selection works diff erently, depending on the tool.

Selection Mode checkbox

• Polygonal lasso

– Click to set the selection line’s starting point.

–  Move the mouse and click to create a straight segment, attached to the previous 
point.
Repeat to create additional segments.

– To close the selection, double-click, or single-click on the starting point.

• Normal lasso

– Click and drag the mouse to draw a freehand selection.

– Release the mouse button to close the selection.

• Magnetic lasso

– Click and drag the mouse as with the Normal lasso. If an edge is within the Width 
setting, the selection path snaps to the edge.

– To close the selection, double-click, or single-click on the starting point.

Choosing a Lasso

– The Polygonal lasso is ideal for areas with straight sides, and good for large areas 
(because you don’t have to hold down the mouse button).

– The Normal lasso is good for areas with curved sides. It’s not the best choice for 
large areas, because you have to hold down the mouse button as you drag.
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A selection drawn with the polygonal lasso

 3.7.2 Fitting the Selection to the Area’s Edges

The area to be replaced usually has at least one irregular border (such as the mountains 
in this sample photograph). It’s diffi  cult to draw irregular borders exactly, and you don’t 
have to. You can draw approximate borders, and Photomatix will fi t them for you by 
"fi nding the edges".

Finding the edges

The borders of the area you want to replace 
are almost always at edges — large changes 
in brightness between adjacent pixels. In the 
sample photo, the transition between the 
light sky and the darker mountains is an edge.

Selecting the Attach to Edges checkbox causes Photomatix to search for an edge near 
the selection path you drew. The selection path is then redrawn along the edge — in 
this case, the mountains.

Attach to Edges checkbox

Polygonal selection after clicking "Attach to Edges"

The Contrast setting (Low, Medium, High) determines whether a diff erence in 
brightness is large enough to be detected as an edge. The higher the setting, the 
greater the brightness diff erence has to be.
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The Width box (next to the Attach to Edges box) sets the maximum distance 
Photomatix searches (in pixels) from the original selection path. If Photomatix fi nds an 
edge within the Width setting, the selection is redrawn to fi t the edge. If Photomatix 
fi nds a border of the image, the selection is redrawn along the border.

Changing the Width or Contrast setting immediately redraws the selection path to 
refl ect the new value.

To undo the edge fi t, clear the Attach to Edges checkbox. 

3.7.3 Replacing the Selected Area

Right-click (Windows) or control-click (Macintosh) anywhere within the selection. A 
contextual menu appears.

– If you loaded bracketed photos, the menu identifi es them by their exposure 
diff erence, relative to the “normal” exposure. Click the photo at the EV you want.

– If you loaded a single image, click "Replace with source".

Replacing the selected area

If you prefer not to see the lines marking your selection, uncheck the Selection Mode 
checkbox.

To discard the replacement and return to the initial preview, right-click within the 
selection and select the checkmarked item in the contextual menu.

Returning to the initial preview
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 4 Automating with Batch Processing
Use batch processing to automatically process image fi les. The batch processing tool 
saves time processing many images. Photomatix Pro off ers two diff erent batch modes:

• Batch Bracketed Photos: Processes bracketed sets using HDR Tone Mapping and/
or Exposure Fusion all in one step, which can save you a lot of time when you have 
many bracketed sets to process.

• Batch Single Photos: Processes multiple single image fi les using Tone Mapping.

 4.1 Batch Processing Bracketed Photos
This section describes batch processing of bracketed photo sets, taken under multiple 
exposure settings.

Batch Processing of bracketed photos

 4.1.1 Using Batch Processing

To batch process multiple sets of bracketed photos follow these steps.

1. Open the Batch Processing of Bracketed Photos window by:

Clicking the Batch Bracketed Photos button 
in the Workfl ow Shortcuts panel

OR

Selecting Batch Bracketed Photos from the 
Automate menu.

Note
The Custom settings or multiple presets 
window allows you to process multiple 
bracketed sets with multiple presets. 
This more advanced batch option is 
explained in section 4.1.3 below
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4.1.2  Custom Settings or Multiple Presets window 

The Custom Settings or Multiple Presets 
window is accessed by clicking the Set … 
button at the top of the batch processing 
window. 

This window allows you to compile a list of multiple built-in presets and/or custom 
settings, to be applied to a single bracketed image set or to a batch of bracketed image 
sets. This feature may be thought of as "Preset batches". The presets batch lists compiled 
in this window are applied to the image set batches which are specifi ed in the Source 
frame of the main batch window.

Click "Set …" to set up preset batches

2. Select a preset from the Use: Preset menu. 
This preset will be applied to all the 
bracketed sets in this batch. 

3. Confi gure basic preprocessing options, to 
specify alignment, ghost removal, noise 
reduction, and whether to create and save an unprocessed 32-bit merged fi le.

4. Select the number of exposures to combine using the pull-down menu below 
the checkboxes. For example, select “3” if your bracketed sets consist of three 
exposures each.

5. In the Source area, select the folder where the bracketed photo sets are located. 
The fi les are arranged in alphabetical order. "N" fi les at a time are processed with 
"N" being the number specifi ed in the previous step.

6. To save the results in a diff erent folder than the folder containing the source 
photos, select Custom location option in the Destination frame at the bottom 
right of the window, and then click Choose Location … to specify where to save 
the processed images.

 OR

 Accept the default of Created under source folder to create a subfolder with the 
name PhotomatixResults in the source image folder.

7. In the Destination pane, select the output fi le type. When using JPG fi le output, 
select the amount of JPEG compression. 100 gives the least compressed JPEG fi le, 
with most image quality retained.

8. Click Naming and Output Options if you would like to rename, resize, add 
contrast or sharpen the saved images.

9. Click Run to start batch processing.

While the batch is running, the processing status will display in the area below the Run 
button. When processing is complete, a link to the batch results will be displayed.

Note
The More Preprocessing Options … button 
provides access to deeper preprocessing 
settings. 
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Preset batches applied to bracketed sets provides a wide range of processing options. 
You may wish in some instances to work with just a single bracketed set, and apply a 
batch of 20 or 30 diff erent presets to it, allowing you to conveniently test which presets 
give the most pleasing results for a given image set.

Another strategy is to apply several diff erent favorite presets to multiple image sets. Be aware, 
while exploring this tool, that the batch results can become very large.

Custom Settings or Multiple Presets window

For example, 30 Presets applied to 30 bracketed sets will output 900 processed images. Plan 
ahead for the processing time and the disk space required when combining large preset 
batches with large image set batches. 

 To set up a batch of existing presets, follow these steps:

1. Select a Built-in preset, or one of your own saved presets, from the Preset menu and 
then click Add. This preset will appear in the list frame.

2. Repeat step 1 as many times as you like, to add additional presets to the list.

3. If you wish to remove a preset from the list frame, select it and click Remove.

4. You may now click OK to close this window. 
The specifi ed presets will be applied the next time a batch is run.

To set up a batch of modifi ed presets or new custom settings, follow these steps:

1. Select a method from the Custom Settings menu, and then click Set …
The Settings Adjustments window for the selected method will open.
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2. Select a method preset from the Presets: menu, and modify as desired.

 OR

 Modify the existing settings. The existing settings are the default for that method.

3. Click OK. The new custom setting will be added to the list frame.

4. Repeat steps 1, 2 and 3 as many times as you like, to add additional custom settings to 
the list.

5. If you wish to update a previously added custom setting, select it in the list frame, 
and click Update …

6. If you wish to remove a custom setting from the list frame, select it and click Remove.

7. You may now click OK to close this window. 
The specifi ed presets will be applied the next time a batch is run. 

 4.1.3 More Preprocessing Options

Use the More Preprocessing Options … 
button to access more advanced 
settings, some of which provide deeper 
control over the basic preprocessing 
settings available in the main batch 
window. 

 4.1.4 32-bit HDR File Creation
Advanced Settings

Force Exposure Values spacing to: 
Forces the EV spacing to the specifi ed 
value. This option can be used when the 
exposure information is not available 
in the EXIF data, if two or more images 
have the same exposure information, or 
to force the EV spacing in all cases. In the 
latter case, the exposure information in 
the EXIF data is ignored. 

Please refer to sections 2.1.2 and 2.1.6 
above for a description of the other 
preprocessing settings.

More Preprocessing Options window
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 4.1.5 Batch Processing Subfolders

When your bracketed series are located in 
multiple folders, they can all be processed in 
one run, provided they are in subfolders of the 
same parent folder. To batch process multiple 
subfolders, check the Process subfolders option 
at bottom of the Source frame on the Batch 
Processing dialog and select sequentially. When “Process subfolders sequentially” 
is selected, the batch will process the bracketed image fi les in one subfolder and then 
move on to the next subfolder, all of which are contained in the main parent folder.

Processing Series of Photos with Varying Numbers of Exposures

When your bracketed sets are composed of varying numbers of exposures, you can 
use “Process subfolders sequentially” to combine the exposures in these sets in one 
batch run. Place each set in a separate subfolder, group the subfolders under a parent 
folder, select Process subfolders sequentially and select All from the pull-down 
menu for the number of images to process at one time.

Grouped by Exposures Option

If you are processing bracketed photos that will be part of a panorama, you may fi nd 
it useful to be able to organize your photos in such a way that all exposures of the 
same levels are in the same folder. Let’s take as an example a panorama composed of 
four views that need to be stitched, with each view having been taken under three 
exposures: -2, 0, +2. You will then have 12 photos, and may need to place them in three 
separate subfolders composed of four photos each as follows:

• Subfolder1 contains the four photos for the panorama taken at EV -2

• Subfolder2 contains the four photos for the panorama taken at EV 0

• Subfolder3 contains the four photos for the panorama taken at EV +2 

If you check “Process subfolders” and select “grouped by exposures”, the batch will 
combine the fi rst fi le of Subfolder1 with the fi rst fi le of Subfolder2 and the fi rst fi le of 
Subfolder3. The batch will then combine the second fi le of Subfolder1 with the second 
fi le of Subfolder2 and the second fi le of Subfolder3, and so on for the third and fourth 
fi le of each subfolder.

Note
All of the subfolders must be contained in 
the main parent folder for this option to work 
properly.
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 4.1.6 Advanced Selection Options

The following items are accessed from the Process frame when you click Advanced 
and click Options to confi gure automatic selection of bracketed image fi les. 

Click Automatically detect the number of bracketed frames when processing a 
folder that contains fi les in addition to those in the set of bracketed frames or when the 
number of frames in the set varies. Photomatix Pro uses the metadata from the image 
fi les to perform automatic bracketed set detection. 

• Specify a range using the two drop-down lists to automatically detect the number 
of bracketed frames.

• Move the Maximum time between two successive frames slider right or left 
to allow more or less time (read from the metadata). If your camera is set on 
continuous shooting and takes 3 frames/second, for example, then the slider could 
safely be set on 1 second.

• Click Select only part of 
the frames in bracketed 
set to load only selected 
frames from a bracketed 
set.

• Specify the total number of 
frames in each set using the 
drop-down list.

• Select the specifi c frames 
to process from the list. 
Select more than one 
fi le by holding down the 
Control key (Windows) or 
Command key (Mac) and 
clicking on the desired 
frames.

Advanced batch processing options
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4.2 Batch Processing Single Images
To process a batch of single image fi les:

1. Open the Batch Tone Mapping of Single Photos window by:

 Click the Batch Single Photos button in the Workfl ow Shortcuts panel

 OR 

 Select Batch Single Photos from the Automate menu.

2. To select the source folder that contains the fi les, click Select Folder, and 
navigate to the folder that contains the fi les and click OK.  
The folder path and the fi les in the folder will be displayed.

3. Optionally, you may select a subset of the displayed fi les to process:

 Hold the Control key (Windows) or Command key (Mac), and click to specify fi les 
for processing.

4. To process the selected fi les using an existing preset, select a preset from the Use: 
Preset menu.

 To Process the selected fi les using a new custom setting, select a method from 
the Use: Custom Settings for menu, then click Set..., and then confi gure the 
preset as desired.

5. Click the checkboxes for noise reduction and CA correction, if needed.  

Batch Tone Mapping of Single Photos
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6. To select a destination folder, click Created 
under Source Folder to save the images in 
the same folder as the source fi les.

 OR

 Click Customized Location to save the 
images in a diff erent folder.  

 Click Choose to select the destination 
folder.  The folder path will be displayed.

7. Select the output fi le type.  When using 
JPG fi le output, select the amount of 
JPEG compression. 100 gives the least 
compressed JPEG fi le, with most image 
quality retained.

8. Click Run.  The batch processing status displays.

When batch processing is complete, a link to the batch results will be displayed.

Note
The Batch Single Photos feature is 
intended for automating the processing of a 
lot of photos. To process a single image fi le, 
load the image fi le using the information in 
Section 2.2.

Note
To remove the watermark, Photomatix Pro 
requires that the image was not retouched 
after the watermark was added to it. If 
the brightness or contrast of the image 
was changed, or the image was double 
tone mapped, or cropped or resized, then 
Photomatix will not be able to remove the 
watermark..
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5 Tips and Techniques
This section provides tips for working with images in Photomatix Pro. More tips and 
techniques, and regularly updated information, can be found on the Photomatix Pro 
FAQ on the HDRsoft website at http://www.hdrsoft.com/support/faq_photomatix.
html.  

 5.1 Integrating Lightroom and Photomatix Pro
You can export photos for processing in Photomatix Pro directly from Lightroom and 
reimport them back into the Lightroom library.

The Lightroom Export to Photomatix plug-in is free and included with the Photomatix 
Pro package. Please refer to the HDRsoft website at http://www.hdrsoft.com/
download/lrplugin.html for installation instructions and a short tutorial showing how 
to use the Lightroom export plug-in for HDR processing in Photomatix Pro. 

 5.2 Processing RAW fi les in Third-Party RAW Converters 
When using a third-party RAW converter, develop the RAW images with the following 
settings.  

Working with curves in LightroomBasic Settings in Lightroom
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As an example, the screenshots show the settings in Lightroom: 

• White Balance: Use the same white balance for all source photos.

• Basic settings: Set all to zero. It is particularly important to set the Blacks setting 
to zero.

• Curves: Parametric and Point Curves should be linear.

• Details: Set the Sharpening Amount to zero. 

5.3 Dealing with Noise 
When you process your photos using Exposure Fusion, the fused image will tend to 
show less noise than the source images. This is because Exposure Fusion works by 
directly combining your bracketed photos, thus averaging out noise.  However, when 
you create a 32-bit HDR image, your bracketed photos are assembled in linear space 
into an image that spans the full range of luminance values captured by the camera. 
If the lightest photo of your exposure sequence is not bright enough to expose the 
shadows of the scene, then the noise in the source photographs will be transferred 
to the HDR image. Noise in the HDR image will then be made more apparent by tone 
mapping, especially with Details Enhancer as this tone mapping method increases 
local details. 

Though Photomatix Pro includes options to reduce noise, it is still always better to 
avoid noise at capture time as much as possible. There are two tips to ensure a low 
noise level: 

• Tip 1: Set a low ISO setting (ISO 100 or lower) whenever possible 

• Tip 2: Overexpose suffi  ciently, ensuring that the lightest image of your exposure 
sequence has its shadows in the mid-tones.

 5.4 Photomatix Pro and Color Management 
Photomatix Pro supports color management even if RAW fi les are processed. You 
should use the same working space in Photomatix Pro as you use in other image 
editors (e.g. Photoshop).

Photomatix supports the three most popular working spaces:

• sRGB: Use if the images are created only for the web.

• Adobe RGB: Popular working space for printing if extremely saturated colors are 
not used.

• ProPhoto RGB: Wide gamut working space. This should never be used for 8-bit 
images.

For all JPEG and TIFF fi les, Photomatix Pro preserves the color spaces of the source fi les.
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Glossary

 AEB Mode (Automatic Exposure Bracketing). DSLR cameras and some compact digital 
cameras off er this feature. It enables you to automatically take three 
or more exposures in a row: one at the proper exposure, one or more 
underexposed, and one or more overexposed.

 Aperture
Priority

In Aperture Priority mode, you select the aperture and the camera 
determines the correct shutter speed for the available light. The shutter 
speed also depends on ISO sensitivity. This is the right mode for shooting 
bracketed shots for HDR (refer to Section 1 for more information).

 Bit Bits represent digital data in computers. Digital Images are made of bits.  A 
bit depth corresponds to 2^(Bit Depth) levels (e.g. 256 for 8-bit).

 Bit Depth The number of bits a fi le type uses to represent a pixel's color at a given 
location in an image.

 Bracketed 
images

A group of photos taken with the Automatic Exposure Bracketing function 
of a camera, resulting in photos of the same scene taken with diff erent 
exposures.

 Chromatic 
Aberration

As the lens focuses diff erent wavelengths slightly diff erently, chromatic 
aberration occurs. For example, the purple fringing you often fi nd around 
edges (leaves in front of a bright sky).

 Contrast
Ratio

Another way to describe the dynamic range of a scene.  The ratio between 
the darkest and brightest areas.

 dSLR Digital Single Lens Refl ex camera.

 Dynamic
Range

In the context of photography, the total range of light intensity in a scene, 
from the deepest shadows to the brightest highlights.

 EXIF The Exchangeable Image File header contains information about the 
image, the camera, location, date and time and camera settings.

 Exposure The amount of light that enters a camera for the length of time the shutter 
is open.  Exposure depends on aperture and shutter speed, as well as the 
camera’s sensitivity to light  (controlled by the ISO).  "Exposure" is also 
shorthand for a photograph or frame (a frame of fi lm).

 Exposure
Fusion

Combination of bracketed photos in such a way that highlight details 
are taken from the underexposed photos and shadow details from the 
overexposed ones.

 EV (Exposure 
Value)

A measure of exposure which is the equivalent of a stop.  In the absolute 
sense, EV is defi ned as the exposure from a photo taken at 1 second, f/1, 
and ISO 100.  In the relative sense, the correct exposure is normally 0 EV 
and any deviation is measured in positive or negative EV from that mark. 
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 HDR High Dynamic Range.

 HDR Image Strictly speaking, an HDR image is an intermediary image with 32 bits per 
color channel (96 bits per pixel).  An HDR image is the result of merging 
photos of the same scene taken under diff erent exposure settings and 
stored in special HDR image format. The 32-bit intermediary HDR image 
must be processed with tone mapping for proper display on standard 
monitors and prints. It has become very common to defi ne "HDR image" as 
the result of processing the 32-bit HDR image with tone mapping, i.e. the 
tone mapped output, but this is not technically correct.

 Histogram Histograms represent brightness distribution in digital images. They help 
evaluate correct exposure. The y-axis represents the amount of pixels and 
the x-axis represents the brightness value.

 JPEG A common image fi le format with two primary strengths – a relatively small 
fi le size and universal compatibility.  JPEGs use a lossy compression scheme 
and should not be edited and re-saved. 

 Noise Statistical variations inherent in the sensor system cause noise. Noise 
is always present, but higher sensitivities and smaller sensors usually 
generate more noise.

 Pixel Digital pictures consist of pixels, the smallest units. Each pixel has a color 
that can be represented by 8 or 16 bits or as a fl oating-point number (32bit 
HDR).

 PPI Pixels per Inch. Can be used to describe the actual pixels per inch of a print. 
Often confused with DPI (Dots per Inch), used by color printers to print an 
image.

 RAW File A fi le containing the raw data from the camera sensor.  RAW fi les do not 
have a color profi le or other stylistic preferences permanently applied. 

 TIFF A comprehensive image format that off ers lossless compression schemes 
for smaller fi le sizes with higher quality.  This format is suitable for editing 
and printing but not publishing on the Web.

 Tone Mapping Processing a 32-bit HDR image into an image that can be properly viewed 
on monitors and in prints.



  Resources

FAQ

You can fi nd more tips, techniques, and regularly updated information in the 
Photomatix FAQ on the HDRsoft website at http://www.hdrsoft.com/support/
faq_photomatix.html.   

Learn More

Additionally, the resources page at http://www.hdrsoft.com/resources/ lists Internet 
tutorials, books and DVDs on the subject of HDR photography that, along with your 
own experience, will help deepen your understanding of it.
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